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Revision History 

Date Revised Changes Made 
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5 August 2008 Added additional information for 2.7 release. 
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Important Information 
Avid recommends that you thoroughly read all of the information in this ReadMe file before installing or 
using any new software release. 

Note: Search the Avid Knowledge Base (http://www.avid.com/onlinesupport) for the most up-to-date 
ReadMe file, which contains the latest information that might have become available after the 
documentation was published. 

This document describes compatibility issues with previous releases, hardware and software requirements, 
software installation instructions, and summary information on system and memory requirements, when 
applicable. This document also lists any hardware and/or software limitations. 

Note: Since this release of iNEWS will be more widely distributed than previous versions, some notes 
on important features and changes have been brought forward from previous ReadMe documents.  
Notes that are less important were not brought forward, and users should reference older iNEWS 
ReadMe files for additional change information not contained in this ReadMe. 
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Compatibility Notes and Issues 
This section contains compatibility information related to the iNEWS 2.8.8 release.  

Community Feature 
Due to compatibility issues, users will not be permitted to move or copy stories between remote systems 
when one remote system is running 2.7 and the other remote system is running 2.8. Example: Logging in to 
a 2.8 local system (SYS1) and moving stories between a remote 2.7 system (SYS2) and a remote 2.8 
system (SYS3) will not be allowed. The story must first be moved to the host system (SYS1) before being 
moved elsewhere. Moving from remote 2.7 to remote 2.7 or remote 2.8 to remote 2.8 is allowed. 

iNEWS Client 
The iNEWS 2.8 client software is qualified and supported for use on Windows Vista, Windows 2000 
Professional (SP4), Windows 2000 Server (SP4), Windows XP Professional (SP2 or SP3) and Windows 
Server 2003 (SP1). iNEWS 2.8 is not officially supported for use on any other Windows operating system.  

iNEWS Server 
The iNEWS 2.8 Server is qualified and supported for use on Red Hat Enterprise Linux 3.x and 5.x. 

The iNEWS 2.8 Server is qualified with VMWare Server v1.0.5 and later for Windows operating systems 
and is supported to run in a VMWare image. It must have networking set to BRIDGED to allow a unique 
IP address. 

Command 
The iNEWS 2.8 Server is qualified and supported for use with Command 1.0.1 or later.  

ControlAir 
The iNEWS 2.8 system is qualified and supported for use with ControlAir 1.6 or later. However, for the 
loading of single playlists with between 500 to 1000 stories, ControlAir v1.7.4.4 or later is required. 

MOS Gateway 
The iNEWS 2.8 system is qualified and supported for use with MOS Gateway 2.6.x or later. 

Console Multiplexer 
The iNEWS 2.8 Server requires version 2.0 of the console multiplexer (MUX) software, which is on the 
iNEWS installation CD. The console multiplexer cannot currently display Unicode characters. A terminal 
emulator that supports Unicode characters can be used if Unicode support is required.  

Data Receiver 
The iNEWS 2.8 system is qualified and supported for use with Data Receiver 1.6 or later. 

Fast Text Search 
The iNEWS 2.8 system is qualified and supported for use with Fast Text Search 2.5. If upgrading from any 
FTS version prior to 2.5, a full re-index is required. 

Instinct 
The iNEWS 2.8 system is qualified and supported for use with Avid Instinct 1.1 and 1.6 or later. 

NewsCutter  
The iNEWS 2.8 system is qualified and supported for use with NewsCutter NRCS Tool 6.1.5 or later. 
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Teleprompter 
The iNEWS 2.8 system supports the following teleprompter software: WinPlus BDL Unicode version 
6.8.7.3 and WinCue version 1.30 (build 674 or higher). 

Changes between 2.8.7 and 2.8.8 

Printing 
• In previous versions of iNEWS 2.8, local printing options WinScriptSplit and WinSequentialNumbering 

only applied to the English client. This is fixed. The new local printing options now work in all languages. 

Monitor Server 
• In the 2.8.7 version of iNEWS, the monitor server could hang during iNEWS Command's ASSIGNID 

workflow. This is fixed. 

• Logging has been enhanced for the iNEWS monitor server. When monitor issues are encountered, please 
contact Avid for assistance in logging monitor activity. 

User Interface 
• In previous versions of iNEWS, using multiple workspaces to view the same queue could result in a new 

story being inserted into the wrong workspace. When this occurred, edit lock issues could arise. This is 
fixed. 

SYSTEM.MAP 
• In previous versions of iNEWS, including trailing whitespace in the final parameter of a SYSTEM.MAP 

entry could result in a parsing failure. For example, a space character after the 'storytext' MOS parameter 
would cause the 'storytext ' to not be recognized. This is fixed. Trailing whitespace is now ignored. 

Changes between 2.8.6 and 2.8.7 

Queues 
• In previous versions of iNEWS 2.8, the story count in a refresh queue was not updated for a user who 

deleted stories. The count was updated for other users watching that queue. This is fixed. The active and 
inactive users watching a queue will now all receive count updates. 

• In previous versions of iNEWS, copying a story from a queue with one index field to a queue with a 
different index field could result in the wrong value being used to index the story in the destination queue. 
This is fixed. 

Command Integration 
• In previous versions of iNEWS 2.8, manually changing the value of a video ID that had been generated by 

Command's ASSIGNID workflow would result in the machine-generated ID being stored in iNEWS and 
the manually-changed video-id displaying in Command. This is fixed. Now, if a user modifies a video ID 
that was assigned by the ASSIGNID workflow, the value will revert to the value generated by ASSIGNID. 
If a video ID needs to be changed, the proper workflow is to clear the value completely, save the story, and 
then enter the new value. After this workflow, the new video ID will appear in iNEWS and Command. 

TXNET 
• In previous versions of iNEWS, txnet sessions that listed the same destination multiple times would not 

reuse the existing connections to the destination. This could result in the destination server running out of 
available sessions. This is fixed. If a txnet joblist has multiple entries for the same destination hostname, an 
open connection will be reused. 
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Changes between 2.8.5 and 2.8.6 

Story Text Lost 
In previous versions of iNEWS 2.8, text copied from external applications into iNEWS stories could be lost 
when saved. The text would show up in blue or pink, and it would not appear when the user returned to the 
story after leaving. This is fixed. Text may still appear in blue or pink when first pasted into a story, but it 
will be converted to normal (black) text and retained when saved. 

Community  

Queue Keylock 
In previous versions of iNEWS, accessing a keylocked queue through a Community connection did not 
work correctly. This is fixed. Now, you can access a keylocked queue through a Community connection. 

Assign Channel Dialog Unavailable Without Accessing SYSTEM.MOS-MAP 
In previous versions of iNEWS, users could not use the Assign Channel dialog on MOS items on a remote 
community server without first accessing the remote server's SYSTEM.MOS-MAP, usually through 
starting a plug-in from the community server or dragging an item from a plug-in to a community server. 
This is fixed. Assign Channel is now available to the user whenever it is requested.  

Russian Translation Errors in 2.8.5 
In previous versions of iNEWS, some Russian menu items were translated incorrectly. This is fixed. Now, 
the Russian menu items have the correct translations. 

Changes between 2.8.4 and 2.8.5 

Printing 
• There are two new local printing options in this version of iNEWS, which are: 

• WinScriptSplit 

• WinSequentialNumbering 

The default for both options is no. However, when WinScriptSplit is enabled, stories are printed in a 
dual-column layout regardless of whether the story has any production cues if the user chooses to print 
all stories, selected stories, or the current story. 

When WinSequentialNumbering is enabled, if the user chooses to print the Queue panel or a portion of 
the Queue panel, the pages of the queue view will be numbered 1, 2, 3, and so forth. Any information 
in the page-number field of each story will be printed as it exists in the system. When a user chooses to 
print all stories, the story pages will be numbered 1, 2, 3, and so forth with the numbers continuing 
across stories. When a user chooses a selection of stories, the story pages will be numbered 1, 2, 3, and 
so forth with the numbers restarting at each story. If a user prints a current story, the story pages are 
also numbered 1, 2, 3, and so forth.  

When the Copies option is set to >1, the page numbering will be repeated on each copy of a story 
regardless of whether the Collate option is selected. For instance, if the pages of story #2 are numbered 
4, 5, and 6, each copy of that story will have pages 4, 5, and 6.  

Note: The page number will only be printed if f-page-number is listed as one of the attributes to 
include in the WinLeftBanner or WinRightBanner options. This is true regardless of whether the user 
decides to enable the WinSequentialNumbering option. 
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Local Databases 
• In previous versions of iNEWS, attempting a Kill All command on a local database queue would inform 

the user that he or she did not have permission to kill all stories. This is fixed. The Kill All command can 
now be used on local database queues, regardless of server permissions or server connection status. 

• In previous 2.8 versions of the iNEWS client software, initial access of a local database that was created 
with version 2.1 client software would result in an error stating, "The parameter is incorrect." This is fixed 
so that the error will no longer appear. 

Miscellaneous 
• In previous versions of iNEWS, zooming in to the Queue panel and then zooming out to a view of the Story 

and Queue panels could result in an incorrect display of the Queue panel's rows. This is fixed. The Queue 
panel now refreshes appropriately when zooming in and out. 

• In previous versions of iNEWS, MOS items in the story body could become corrupted when the story was 
saved. Editing stories with corrupted items would result in save failures and permanent story locks. 
Loading stories with corrupted items to the monitor server could result in blank lines displayed on the 
playout controller. This is fixed. 

• In previous versions of iNEWS, having too many keywords in a keyword search story could cause the 
wireserver to stop running. This is fixed. Now, console diagnostics will appear when too many keywords 
are entered, and the wireserver will continue running. 

• In earlier versions of iNEWS, the Tape color rule included two checks:  

• video-id NotEmpty 

• mos-active NotEmpty 

This has been changed. The Tape rule now only checks for video-id NotEmpty, and a new color rule, 
called MOS Active, has been added that checks for mos-active NotEmpty.  

Both rules default to the same settings, with which a populated video-id or mos-active field results in a pale 
yellow row, but now users can configure different colors or text styles for the separated rules. 

 

Changes between 2.8.3 and 2.8.4 

Languages 
• Translated help files are included in iNEWS now for the following languages: 

• Russian 

• Korean 

• Chinese (Traditional) 

• Chinese (Simplified) 

SYSTEM files 
• In previous versions of iNEWS, Connect to Service would not work if the system ID was hyphenated and 

the second column in SYSTEM.SERVICE contained only a hyphen (-). For example, a system named AV-
ID-A would not work. This is fixed. The second column in SYSTEM.SERVICE can now contain only a 
hyphen and still connect to a system with a hyphenated system ID. 

• In previous versions of iNEWS, monitor would use a best-match approach for form names in 
SYSTEM.MAP event lists, which could create a situation where an incorrect form was sent when a form 
matching the listed name did not exist. For example, if a form named ca-vid didn’t exist, but that name 



  Version 2.8.8 ReadMe 

  10   

was listed in SYSTEM.MAP, it would match a form named ca-video. This is fixed. Now, form names 
listed in SYSTEM.MAP must be an exact match to an existing form name. If there is no match, an invalid 
form error message will appear. 

• In previous versions of iNEWS, font names used in SYSTEM.STYLES had a 15-character limit. This limit 
has been expanded so that font names can be up to 32 characters in length. 

User Interface 
• In previous versions of iNEWS, a user couldn’t select View > Use Form for queues in a remote/community 

server. This is fixed. The View > Use Form menu option now allows use of the remote server’s forms when 
the user is viewing a remote queue. 

• In previous versions of iNEWS, if a user copies a story from a preparation queue into an update-enabled 
rundown queue, which already has that story by the same name, the copy might cause data in the story’s 
event-status and item-channel fields to be cleared from the rundown queue. This is fixed. Blank event-
status and item-channel fields in a preparation story will no longer clear values in those fields that exist in 
the rundown queue. 

• In previous versions of iNEWS 2.8, CTRL-M from Search Results or from within the Queue panel could 
fail to move the selected stories, or the stories could be moved to the bottom of an inverted destination 
queue instead of the top. This is fixed. Using CTRL-M or Edit > Move to... to move stories from the queue 
view will move the stories correctly. 

Searching 
• In previous versions of iNEWS, a period (.) was not considered a valid word delimiter when conducting 

searches. For example, a search would not find the word Avid in a story that contained the URL, 
www.avid.com. The token W_DELIMITERS in /site/dict/words is now used to define all seek 
and fast text search (FTS) word delimiters. Changes to the token will be reflected in seek searches after a 
server reboot. Changes to the token will be reflected in FTS searches after a server reboot and a re-
indexing.  
 
Also, a new console server command, wordbreaks, is available that accepts text and displays how that 
text is parsed for words. By default, the delimiters used are those set in 
/site/dict/words:W_DELIMITERS. A hyphen (-) can be used to display parsing using only 
Unicode default delimiters.  
 
NRCS-A# wordbreaks 
Usage: wordbreaks [-] text-to-be-broken-into-words ... 
       A '-' suppresses using W_DELIMITERS for additional breaks. 

Server 

• The server diagnostics for a client exit have been improved to allow easier troubleshooting. In the case of a 
gnews exit, the message now includes client username, client IP, client version, and server version. For 
other client exits, the message now includes the client IP. For example: 

• gnews exit before: Exit: Error communicating with Client (16) 

• gnews exit after: Exit: Error communicating with Client (16) jsmith 
172.24.96.138 2.8.2.11/2.8.4.4 LINUX RHEL 3 

• rxnet exit before: Connection read error (104) 

• rxnet exit after: Connection read error (104:Connection reset by peer) 
172.24.100.40 

• Beginning in this release of iNEWS, error messages will only appear if the validation action is running in 
debug mode. This enhancement is intended to reduce the number of console messages produced. When the 

http://www.avid.com/�
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device is not running in debug mode, the only messages produced are the notifications sent to members of 
the validation error queue’s notify group. If more messages are preferred, previous behavior can be restored 
by running in debug mode.  

To run in debug mode: 

 Enter the restart command using the following format: restart -1 <device> 

Txnet 
• In previous versions of iNEWS, the CHARSET setting was not retained by txnet when the receiving device 

was restarted. This is fixed. 

• In previous versions of iNEWS, using hostnames longer than 40 characters in txnet jobs would result in the 
txnet connection not being reused after the initial send. This is fixed. Existing txnet connections are now 
reused regardless of hostname length. 

Console Commands 
• In previous versions of iNEWS, the force console command would report success but not modify user 

accounts so that a password change would be required at next login. This is fixed. The force console 
command now sets user accounts properly to require a password change at next user login.  

Right-Aligned Queues 
• In previous versions of iNEWS, text could not be entered into right-aligned fields in the Queue panel if the 

operating system on the workstation was set to a right-to-left (RTL) locale, such as Arabic or Hebrew. This 
is fixed.  

• In previous versions of iNEWS, text did not right-align in left-aligned form fields in the Queue panel when 
the operating system (OS) at the workstation was set to an RTL locale. This is changed. When the 
workstation OS is set to an RTL locale, all right- and left-aligned queue fields will have right-aligned text. 

Changes between 2.8.2 and 2.8.3 

User Interface 
• In previous versions of iNEWS 2.8, users could receive errors stating, “The copy failed: Destination is 

invalid” when copying entire queues that had not been visited in that session. This is fixed. Typing Ctrl + D 
or Ctrl + M after selecting a queue will no longer produce an error when the operation executes. 

 

Changes between 2.8.1 and 2.8.2 

Installation 
• Starting in iNEWS v2.8.2, the iNEWS client software installation program no longer installs or registers 

the following files: iNewsCOM.dll and iNewsCOMU.dll. Both files are still available on the iNEWS 
installation CD, but they are no longer included as part of the iNEWS client installation process. 

User Interface 
• Starting in iNEWS v2.8.2, the iNEWS user interface can span multiple monitors or reside on only the non-

primary monitor. Closing and reopening the application will recall the last position used. However, some 
limitations occur with this new functionality. Please see “Known Issues and Limitations” later in this 
document for more information. 

• In previous versions of iNEWS, typing the keystroke combination of Shift + Enter while in a production 
cue would result in a story save failure. This is fixed.  
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• In previous versions of iNEWS, triple-clicking the left mouse button would not select an entire paragraph. 
This is fixed. Double-clicking selects a word, and triple-clicking selects a paragraph.  

• In previous versions of iNEWS, top-line messages could disappear after a few minutes of inactivity, 
although they would reappear with user activity. This is fixed. Messages remain visible in the message bar 
regardless of user activity. 

Enhancements to the msgclean Console Command 
This section contains modifications to iNEWS with regard to the msgclean console command: 

Wildcard Assumed when No User is Specified 
If no username is specified, msgclean now assumes an asterisk (*), or all users. 

NRCS-A# msgclean –tx 
Jones  8   messages (no such user) 

Smith  1   message (no such user) 

Taylor  2   messages (no such user) 

11 total qualifying messages. 
NRCS-A# msgclean -tx jones 
Jones  8   messages (no such user) 

8 total qualifying messages. 

Removing Messages from Existing or Non-Existing 

The msgclean command now removes messages to existing users as well as non-existing users. When 
the -r option is used, msgclean prompts for approval for each existing user whose messages are going to 
be removed. There is no prompt when removing messages sent to usernames that no longer exist. 

NRCS-A$ msgclean -t west 
west                 7   message 
7 total qualifying messages. 
 
NRCS-A$ msgclean -r west 
Do you wish to remove messages sent to west (y/n)? y 
7 messages removed. 
 

The -x option is added to force msgclean to act only on usernames that no longer exist. Messages removed 
from non-existent users do not prompt for confirmation. The following example shows deletion of three 
messages pending to a guest user. 

NRCS-A# msgclean –tx 
0 total qualifying messages. 

NRCS-A# utraits guest remove 

User guest removed 
NRCS-A# msgclean –tx 
guest        3   messages (no such user) 

3 total qualifying messages. 
NRCS-A# msgclean –rx 
3 messages removed. 

 

The #<days> key is removed and replaced by the ‘-a <age in days>’ option. 

NRCS-A# msgclean -t -a 50 olaughlin 
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olaughlin     7   messages older than 50 days 

7 total qualifying messages. 
NRCS-A# msgclean -r -a 50 olaughlin 
Do you wish to remove messages older than 50 days to olaughlin 
(y/n)? y 
7 messages removed. 

Display or Remove Messages from a Specific User 

The -f <from> option is added to msgclean. This option adds the ability to display or remove all 
messages from a specific user. The <from> username is case sensitive and literal, meaning wildcards 
cannot be used. 

The following example removes messages sent from ‘monitor’ to ‘avid’ 

NRCS-A$ msgclean -tf monitor avid 
avid              496 messages from monitor 
496 total qualifying messages. 
 
NRCS-A$ msgclean -rf monitor avid 
Do you wish to remove messages from monitor to avid (y/n)? y 
496 messages removed. 
 
NRCS-A$ msgclean -tf monitor avid 
avid               0   messages from monitor 
0 total qualifying messages. 
 

Tabular Output for msgclean 

The output of msgclean –t has been enhanced. The output is now tabular, and when used with the -a 
<age in days> option, information is provided showing which users have messages. 

Before:  

NRCS-A$ msgclean -t "#50" 
14730 messages older than 50 days. 
14730 total messages. 
0 messages removed. 

After: 

NRCS-A$ msgclean -t –a "#50" 
allenchou 4 messages older than 50 days 
avid  32 messages older than 50 days 
denise 30 messages older than 50 days 
sheila 23 messages older than 50 days 
... 
14730 messages older than 50 days. 
14730 total qualifying messages. 
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Help Options for msgclean 

The following are the help options that appear when entering the help msgclean command at the 
iNEWS console: 

NRCS-A$ help msgclean 
usage: msgclean-<options> [-f <from name>][-a <age in days>][-x] 
[<username>] 

 

Option Description 

r Remove messages. 

d Show messages that are removed. 

o Show messages. 

t Tabulate messages. 

f Restrict messages to those from the specified sender. Sender is used 
exactly as specified, no case shift. An empty sender can be specified with 
quotes (""). 

a Restrict messages to those older than the specified number of days. 

x Restrict to nonexistent users. 

<username> For specified user. Use trailing asterisk (*) for wildcard match. If no 
username is specified, then an asterisk will be assumed. 

 

Queues 
• In previous versions of iNEWS, adding new queues or folders to an empty directory could result in the new 

entry not being displayed. This is fixed. Queues and folders no longer disappear after creation.  

• In previous versions of iNEWS, navigating from a queue without Text Timing Clocks to a queue with Text 
Timing Clocks and then scrolling down could result in the Text Timing bar displaying several times over 
the story body. This issue is fixed. 

• Local printing options, when printing from a queue, have changed. Users now have an easy way to avoid 
printing certain stories when printing a rundown. Two local printing options—Print selected stories and 
Print all stories in the queue—no longer print stories that have an asterisk (*) anywhere in the PAGE-
NUMBER field. The Print current story option will print a story even if it has an asterisk in the PAGE-
NUMBER field, and printing of the queue view will include stories with asterisks in the PAGE-NUMBER 
field. 

• In previous versions of iNEWS 2.8, copying stories by dragging a queue from the directory view to the 
queue view could result in the order of stories being flipped. This is fixed. Dragging from an inverted 
queue to an inverted queue or from a non-inverted queue to a non-inverted queue will no longer modify the 
order of stories copied into the queue. 

Admin Functionality 
• In previous versions of iNEWS, the umanager functionality that allowed non-superusers to modify user 

settings did not work. This is fixed. Non-superuser members of the SYSTEM.GROUPS queue’s write 
group can now modify user settings after entering the umanager password. 
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Changes between 2.8.0 and 2.8.1 

iNEWS Web Client 
The iNEWS Web Client did not work with iNEWS Server 2.8.0. Web Client users experienced forced 
logout at story save. This is fixed. Web Client users  no longer experience the forced log out when saving 
their stories. 

Job Lists 
In previous versions of iNEWS, the action server could create a directory with no name if its job list was 
constructed incorrectly. For example, the command "dup archive.%Y.%m..%d" would create a 
directory structure that would crash an iNEWS client trying to navigate to the queue. This is fixed. Now, 
action server ignores the extra ".". 

Queues 
In previous versions of iNEWS, large reorders (> 50 stories moved) instigated by a remote session would 
cause the reordering remote session to become out-of-sync with the reordered queue. This is fixed. Now, 
large reorders (> 50 stories moved) instigated by a remote session do not cause the reordering remote 
session to become out-of-sync with the reordered queue. 

Enhancements to the msgclean Console Command 
Changes were made in v2.8.1; however, additional enhancements occurred again in v2.8.2. See “Changes 
between 2.8.1 and 2.8.2 for more details on these modifications. 

Changes made between iNEWS 2.7 and 2.8 

ActiveX Plug-ins 
In previous versions of iNEWS, an ActiveX plug-in would close and immediately reopen to the default size 
whenever a user double-clicked on a production cue, typed Ctrl + E, or selected Edit > Production Cue. 
This has been fixed. Open plug-ins now remain open and retain their size when a user edits a production 
cue. 

User Interface 
• Previous Unicode versions (v. 2.5.0 – v. 2.7.0) of the iNEWS client software lost form height modifications 

when users navigated among stories within a queue. This is fixed. User modifications to the form area 
height now persist among all stories with the same story form. The form height will return to the default 
when the user navigates to a queue or story that uses a different story form. 

• Previous Unicode versions of iNEWS stripped smart quotes out of text pasted from Microsoft Word into 
the iNEWS client application. This has been fixed. Smart single- and double-quotes are now converted to 
standard single- and double-quotes when pasted into an iNEWS story or mail. 

• Previous Unicode versions of iNEWS would lose some formatting, such as Line Breaks, when HTML / 
RTF text was copied from an external source into an iNEWS story or mail. This has been fixed. Formatting 
is now retained when users copy external source into iNEWS stories or mail. 

• In iNEWS 2.7.0, a workstation could appear to hang if a connected, community server became 
unreachable. This has been fixed. Remote server disconnects will no longer affect the functionality of an 
iNEWS workstation. 

• The HardOut clock (center one in graphic shown below) in the Show Timing toolbar now displays hours, 
allowing times greater than 59 minutes and 59 seconds.  
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• The Tape color rule will now be applied to all rows with non-empty MOS-ACTIVE fields or non-empty 
VIDEO-ID fields. Earlier versions of iNEWS only applied the rule to non-empty VIDEO-ID fields. 

• Previous versions of iNEWS could display erroneous "You are about to delete one or more production 
cues. Are you sure you want to continue?" warnings when Delete Production Cue confirmation was active 
and no production cue was present. This has been fixed. The confirmation now only appears when a user is 
actually attempting to delete a production cue. 

• In previous versions of iNEWS, stories dropped to the bottom of a different queue view were treated the 
same as stories dropped to the destination queue's directory view. In the case of inverted queues, the result 
was that the dropped stories would appear at the top of the queue view. This is fixed. Now, stories dropped 
to the bottom of the queue view stay at the bottom of the queue view. 

• In previous versions of iNEWS, attempting to Get All Versions for an unsaved story version could result in 
the client software crashing. This has been fixed. The client software now displays the concatenated 
contents of all versions for the user to copy and paste. 

• In previous versions of iNEWS, deleting a story that was actively being timed through Show Timing would 
cause the client software on other workstations, using or monitoring Show Timing for the same rundown, 
to crash. This has been fixed. 

• In iNEWS 2.7.0, the menu options, Story > Mail Extended and File > Export Story Extended, would repeat 
the text of the first production cue in the story instead of displaying the proper text for production cues 
beyond the first. This has been fixed. 

Community 
• As an expansion to the iNEWS Community feature, users with the appropriate remote permissions may 

now turn on or off the monitor server, as well as load and unload playlists for queues in remote systems. 

• The "Logged in Users" dialog box (Ctrl + L) now displays community connections as well as local 
connections. However, the dialog box does not indicate which connections are local and which ones are 
community. 

• In iNEWS 2.7, stories copied from one community system to another would lose FLOAT and BREAK 
attributes. This has been fixed so that FLOAT and BREAK will successfully copy between systems that are 
both running version 2.8 of the iNEWS software. 

Note: The BREAK attribute will be preserved when copying from a v.2.7 system to a v.2.8 system, but 
FLOAT will not be preserved. 

• Beginning with iNEWS v2.8, system administrators can no longer add a system to its own community file. 
Attempting to do so will display the following: Cannot add <system>, it is this system's name.  

• The ctraits add option has been removed. To add a system to the community file, use: ctraits 
<system> suffix <suffix>. 

• Previous versions of the iNEWS server software required all community members to respond to message 
requests before user login completed. This behavior could result in slow login due to WAN latency and 
server availability. This has been fixed. User login speed is no longer slowed by community message 
checking. See the Avid iNEWS Community Feature Setup and Configuration document for more 
information. 

• Previous versions of the iNEWS server software allowed incoming community connections from 
usernames listed locally as Local Only. The connection was allowed, but the permissions were set to those 
of the Guest or Generic login, which could cause some confusion. This has been changed. If the incoming 
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username is Local Only, the incoming connection is disallowed. See the Avid iNEWS Community Feature 
Setup and Configuration document for more information. 

• The cmr - Community Message Retrieval - server has been created to handle Community message 
checking. See the Avid iNEWS Community Feature Setup and Configuration document for more 
information. 

Instinct 
In previous versions of iNEWS server, using iNEWS Instinct to insert Instinct items into stories containing 
MOS items could result in a story save failure and an Instinct client disconnect. This has been fixed. 

Server 
• In this version of iNEWS, the device limit in /site/config was increased from 3000 to 4096. Device count 

by type (inws, aiws, etc.) must still comply with licensing, but the total device count allowed is now 4096, 
which means that valid device and mailbox number assignments are 1 through 4096. 

• The output formatting of the unbusy server command has been changed. Line breaks have been added 
between fields to improve readability. For instance:  
 
NRCS-A# unbusy show.5p.rundown 
page-number 
presenter 
title         5PM SHOW 
var-1 
status 
video-id 
event-status 
item-channel 
audio-time    0:00 
runs-time     0:00 
tape-time 
total-time    0:00 
endorse-by 
back-time 
cume-time 
modify-date   2008-10-06 08:18:46 
modify-by     jdoe 
 
Did you check with jdoe who is at device 899? 
f locked on 2008-10-06 at 08:18:38 by session 899 
b locked on 2008-10-06 at 08:18:38 by session 899 
p locked on 2008-10-06 at 08:18:38 by session 899 
Unbusy? (n/y/q) 

 

Languages 
The following IMEs are now qualified for Chinese-character input: WangMa Wubi 86 and WangMa Wubi 
98. 

Miscellaneous 
A new dictionary token has been added to /site/dict/queues. The token, 
Q_SCRIPT_TEMPLATES, is reserved for future development. 
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Changes made between iNEWS 2.6.8 and 2.7 

Upgrading 
• In earlier versions of iNEWS on Red Hat Enterprise Linux 5.0, the 'hiddenmenu' option was not removed 

from /boot/grub/grub.conf. The 'hiddenmenu' option is now removed during full iNEWS Server 
installs. 

• In earlier Unicode versions of iNEWS Server, converting a CP1252 database to a Unicode database would 
cause the loss of some characters. This has been corrected, and all characters are now converted properly. 

• After an upgrade to 2.7, systems with rsearch devices in /site/config will not configure. The 
system will display a message similar to the following: 

WAVD-A# configure 
line 215: unknown type: rsearch 
rsearch 900    -       gnews   -       ; 
System not configured 

 

Remove any Remote Search devices that exist in /site/config. Remote Search has been replaced by 
Community. 

Windows Registry 
The Windows Registry key location has changed for the iNEWS client software. It is now located at: 
HKEY_CURRENT_USER\Software\Avid Technology\iNEWS. 

Production Devices 
The maximum number of devices allowed per rundown has been increased from 10 devices to 20 per 
rundown. 

Monitor Server 
• The monitor server is no longer restricted to 500 stories per rundown. The limit was increased to allow 

monitor server to load up to 1000 stories per rundown to ControlAir v1.7.4.4 or iNEWS Command. A 
system message will inform the user if an incompatible version of ControlAir is detected. While ControlAir 
now supports up to 1000 stories in a single playlist, to ensure the best performance in ControlAir, Avid 
recommends loading a playlist with no more than 750 stories from iNEWS to ControlAir. 

• In previous versions, if both MOS Gateway and Command servers were assigned forms in the iNEWS 
rundown’s SYSTEM.MAP, a network communication failure to MOS Gateway would occur when the 
monitor server loaded stories. This issue is fixed. 

Community 
• The iNEWS Community feature allows customers with multiple iNEWS systems to share content and 

collaborate on stories.  A user can view, edit, and search for content stored on any of the iNEWS systems 
from a single instance of the iNEWS Client. For more information on how to configure iNEWS for this 
feature, see the Community Configuration document provided in PDF format for free on the Avid 
Knowledge Base at: www.avid.com/onlinesupport. 

• To activate the Community logging feature, you must modify the W_LOGTYPES token in 
/site/dict/words. 
Before:  W_LOGTYPES=/D 
After: W_LOGTYPES=/DC 

http://www.avid.com/online�
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• In previous versions, iNEWS would reject the Get from Template command during the creation of a user 
account if the username existed only on a Community server. This issue is fixed. 

• In previous versions, the Community file required at least one active flag—messaging, incoming, or 
outgoing—per Community server. This has been changed.  Systems can now be added to the Community 
file with no active flags. For example: 

list C 
 SYSTEM SUFFIX moi GROUP 

 AVID AB --- - 

 INEWS AB m-- - 

• When a user enters the list s command on a remote system, the output displays a (c) for community 
sessions in which a user logged in with the generic login. For example: 

list s 
 G1293 frs-spidey            B 

 C2900 frs-linus             C (c) 

 C2013 frs-snoopy            D (c)  

User Interface 
• The iNEWS status bar no longer displays REF for Refresh queues. Instead, the display shows a story count, 

which is the number of stories that will be loaded with a monitor load. Specifically, total stories minus 
floated stories. The background color of the story count is used to indicate proximity to the monitor story 
limitation, which is 1000. At 951 the background color becomes yellow. At 1001 the background color 
becomes red, indicating that the monitor server will exit if a load is attempted. 

• In previous versions, the keystroke combination for navigating to the address bar in the iNEWS-hosted 
Internet Explorer browser was Ctrl + Alt + Tab, but that is now used by the Vista operating system, so in 
iNEWS, the new navigation keystroke is Ctrl + Alt + T. For Windows XP, both keystroke combinations 
work.  

• In some previous versions, Ctrl + V would not paste text over existing text in the Queue panel field. This 
issue is fixed. 

• In previous versions, iNEWS did not word-wrap the Message of the Day. This issue is fixed. 

• In previous versions, script timing could produce unpredictable results when connected only to a local 
database. This issue is fixed. The iNEWS client software now creates Windows Registry values for 
readrate and wordlength. These values are updated whenever the workstation connects to an 
iNEWS Server and a user at that workstation edits a story. The Windows Registry values are used for script 
timing when connected only to a local database. If the workstation has never been connected to a server, 
then default values are used, which are: 180 for readrate and 1 (one) for wordlength. 

Searching 
The iNEWS system no longer displays the “Finished searching the story” popup before finishing the actual 
search. 

Queues 
• In previous versions, a user could simultaneously select the Watch Appends and Refresh check boxes in the 

Queue Properties dialog box. This is no longer permitted. 

• In previous versions, stories copied to a composite list retained the read and write group of the original 
source queue. This had changed. Composite List stories now adopt the read and write groups of the 
Composite queue in which they are copied.  
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Languages 
Russian and Korean localized iNEWS clients are now available. The installers are available on the iNEWS 
installation CD. See the section called “Qualified Asian Languages and IMEs” later in this document for 
more information on the Korean language. 

Changes made between iNEWS 2.6.6 and 2.6.8 

FTS 
New to iNEWS 2.6.8, the speed of FTS indexing was improved in this release. 

Telnet 
In this version, Connect to Service works with telnet, SSH, and rlogin, even after upgrading from 2.1.x. 

Rxnet 
• In previous versions, if an IP address was specified for an rxnet device, no connections would succeed to 

that device. This issue is fixed. 

• When RX_HOT_TO_GO=0 is set in /site/env/rxnet, then rxnet will not print Hot-To-Go diagnostic. 

Licensing 
In previous versions, license changes required a workserver reboot. That is no longer the case. In 2.6.8, 
license changes can be applied with the configure -n command. 

Macros  
In previous versions, keyboard macros stopped working if the mouse pointer was not hovering over the 
iNEWS workspace. This is fixed. 

Monitor Server  
• In previous versions, if the primary Command Server was offline, the iNEWS monitor server would 

experience load times of three to four minutes to load to the backup Command Server. This has been fixed 
so that the monitor server’s load time to the backup Command Server is around 30 seconds whenever the 
primary Command Server is offline. 

• In previous versions, the monitor server might inaccurately report a Command Server error even though 
nothing was being loaded to Command. This issue is fixed. 

• In previous versions, the monitor server would exit with a segmentation fault when a story with a MOS 
item in the first production cue was made into a Break. This issue is fixed. 

Production Cues 
In previous versions, some stories would result in errors when saved with production cues pasted into them. 
This issue is fixed. 

Story Forms 
• In previous versions, duplicate video items could result if a rundown’s story form did not contain the item-

channel field. This issue is fixed. 

• In previous versions, the modify-by form field was not updated with the correct username if the updating 
user has a shorter version of the original user’s name. For instance, if a user named “Stan” updated a story 
previously modified by a user named “Stanley”, then the name “Stanley” would remain in the modify-by 
field. This issue is fixed. 
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SYSTEM.MAP 
• The iNEWS system will now send error messages to the user’s workstation and the console when duplicate 

server names are configured for a rundown in the SYSTEM.MAP. 

• To ensure that unwanted fields are not sent to the wrong server, each server form listed in a rundown’s 
SYSTEM. MAP story is now parsed and stored separately.  

• In previous versions, if you configured a rundown with a video-id form field by listing a MOS Gateway 
Server first and a Command Server second in SYSTEM.MAP, when a show was loaded, the system would 
load video items to Command even though it wasn’t the primary device. This issue is fixed. The monitor 
server utility program now checks the primary server type and processes accordingly. 

• In previous versions, MOS Gateway would only load simultaneously with Command if the selected 
Command Server was in the backup position in SYSTEM.MAP. This issue is fixed. 

• In previous versions, a composite list had to be specified in SYSTEM.MAP to avoid a potential problem 
with some MOS devices with regard to sending unnecessary Update Story events to the iNEWS MOS 
Gateway.  For instance, when this occurred, the Omnibus Columbus would unload the clip, check its 
inventory, then load the same clip again, during which time it was impossible to play that clip. This issue is 
fixed. 

Changes made between iNEWS 2.6.5 and 2.6.6 

sh Install Upgrade 
In the previous version, running the install script for with the ‘upgrade’ argument reported success when 
upgrading from version 2.6.3 to version 2.6.5, but the install was not actually successful.  

This is fixed. Now, the script detects when the version being upgraded is less than 2.6.5.x. When this 
situation is detected, the user is notified, and a full install is initiated. 

Adding new CG Templates 
In the previous version, adding new CG templates after an upgrade from version 2.0 to version 2.6 removed 
most of the original templates.  

This issue is fixed. Now, when adding new CG templates after an upgrade from version 2.0 to version 2.6 
no templates are removed. 

Story Printing Removed Production Cues 
In the previous version, when a story was printed without first being viewed from the current iNEWS 
session, production cues for that story did not appear on the printout. This issue was most apparent with 
batch and zoom mode printing. 

This issue is fixed. Now, when a story is printed, the production cues appear on the printout. 

Ctrl + Delete Only Deletes Character Following the Cursor 
In previous versions, in the production cue view, placing the cursor in the middle of a word and then typing 
Ctrl + Delete only deleted the character immediately following the cursor. 

This issue is fixed. Now, placing the cursor in the middle of a word and typing Ctrl + Delete deletes the 
remainder of the word beyond the cursor. 
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Changes made between iNEWS 2.6.2 and 2.6.5 

iNEWS Server 
• Support for Red Hat Enterprise Linux version 5.0 – Beginning with iNEWS 2.6.5, Red Hat Enterprise 

Linux 5.0 will also be a supported operating system for the iNEWS Server, in addition to Red Hat 
Enterprise Linux 3.0. 

• Server logs directory change – Previous versions of iNEWS placed server logs in 
/var/local/iNEWS/. Beginning with iNEWS 2.6.5, the server logs will be placed in 
/var/log/iNEWS/. 

• FTP and Telnet port changes (Red Hat 5 Only) – Red Hat 3 versions of iNEWS use TCP port 600 for 
FTP and TCP port 49152 for Telnet. Beginning with iNEWS 2.6.5 on Red Hat Enterprise Linux 5, FTP 
uses TCP port 49152, and Telnet uses TCP port 49153. The iNEWS version 2.6.5 on Red Hat 3 continues 
to use FTP 600 and Telnet 49152. 

• Some stories FTPed into iNEWS result in a second, blank story being created – In previous versions of 
iNEWS, if a story FTP’d into iNEWS begins with a Byte Order Mark, a blank extra story would be created 
in addition to the actual story.  This issue is fixed. 

• Server can sometimes send incomplete stories – In a specific situation, it was possible for the server to 
supply an incomplete story to a client.  If a story contained an invalid backlink, the gnews program would 
stop at the invalid backlink and send the story.  Gnews is fixed to tolerate invalid backlinks. 

• Underscores in usernames/groups cause mail to fail – In previous versions of iNEWS 2.6, iNEWS mail 
would fail when sending to a username or group name with an underscore.  This issue is fixed. 
 
Known Issue - iNEWS Mail cannot be used to send to external e-mail addresses that include underscores; 
the sending user will receive a "Returned mail:" message. 

• Monitor server hangs when iNEWS Command is used to reorder/insert stories – In previous versions 
of iNEWS, reordering or inserting stories using iNEWS Command could cause the monitor server to hang. 
This issue is fixed. 

• Monitor server hangs when connecting to an iNEWS Command Server – In previous versions of 
iNEWS, the monitor server could experience hangs when connecting to iNEWS Command using rundowns 
containing multiple CG devices. This issue is fixed. 

• CGs invalid when added to loaded rundowns – The iNEWS Server 2.6.2 had an issue where CGs would 
be saved with invalid information if they were added to stories already loaded in Command. This issue is 
fixed. 

• Faster playlist load from iNEWS to Command and ControlAir – Changes have been made to improve 
the speed at which iNEWS playlists are loaded to Command and ControlAir. 

iNEWS Client 
• ThunderSelect Plugin shows blank screen when opening from production cue – In previous versions of 

iNEWS 2.x, when you open a ThunderSelect production cue it would show up blank until the window was 
resized. This issue is fixed. 

• Extraneous buttons available when ActiveX editor is opened from the menu – In previous versions of 
iNEWS, a MOS ActiveX editor opened from the Tools menu showed the OK, Cancel, and Apply buttons. 
These buttons could not be used in this context. The buttons no longer appear when the ActiveX Editor is 
opened from Tools. 

• Default WAV files louder than standard Windows system sounds – In previous versions of iNEWS, the 
default WAV files used for iNEWS events (Bulletin, Flash, Urgent, etc.) were louder than standard 
Windows system sounds. This issue is fixed. 
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• WinPrintHide parameter causes client to hang – In some cases, printing multiple stories with the 
WinPrintHide parameter active would cause the client to hang during printing. This issue is fixed. 

• Queue panel font adversely affecting rundown printout spacing – In previous versions of iNEWS 2.6, 
the font used on the client queue panel could adversely affect the spacing of rundown printouts. This issue 
is fixed. 

• Default print text shading is too dark – In previous versions of iNEWS 2.6, the default shading for 
Presenter, Machine, and Close Caption text was too dark. This issue is fixed. 

• Ctrl + V in message bar duplicates data – In previous versions, Ctrl + V in the message bar would 
double the text copied from the clipboard. This issue is fixed. 

• Double-clicking in the queue panel puts user into edit mode – In previous versions of iNEWS 2.6, 
double-clicking in the queue panel would put the user into edit mode. This issue is fixed. 

• Find All dialog in non-English versions displays no icons – In previous versions of iNEWS 2.6, the Find 
All dialog of non-English installs would display no icons. This issue is fixed. 

• Dropping MOS objects into queue panel causes 'reorder' prompt – In previous versions of iNEWS 2.6, 
dropping MOS objects into a queue panel caused the Reorder Confirmation dialog to appear. This issue is 
fixed. 

• Upgrading from iNEWS 2.1 to 2.6 causes loss of toolbar characters – In previous versions of iNEWS 
2.6, toolbars upgraded from iNEWS 2.1 could lose some non-Unicode characters. This issue is fixed. 
Upgrading toolbars now uses the selected Windows “Languages for non-Unicode programs” setting to 
establish the codepage used for converting from non-Unicode to Unicode. 

• F3 in story body does not find next occurrence of search term – In previous versions of iNEWS 2.6, 
using F3 to find the next occurrence of a search term would only find the first occurrence. This issue is 
fixed. 

• Backtime does not calculate correctly with a manually entered total time of 0:00 – In previous versions 
of iNEWS 2.6, entering 0:00 into Total Time would not correctly re-calculate backtime. This issue is fixed. 

• iNEWS installer requires Name and Company Name – Previous versions of the iNEWS installer 
required entry of a name and company name to complete the installation. Entry of name and company 
name is no longer a requirement. 

Known Issue 
• Right-to-Left (RTL) language input requires specific Windows setup – For input of RTL languages to 

work properly, the operating system locale must be set to either Hebrew or Arabic. This OS setting is found 
in Control Panel > Regional and Language Options > Regional Options > Standards and formats. Support 
for additional RTL languages will be improved in future. 

iNEWS Community Messaging 
New to iNEWS 2.6.5 is the ability to send messages to users on remote iNEWS systems without having to 
append a system name (@AVID-A, for example) to the recipient's username. This messaging is achieved 
by adding remote systems to a Community on the local system using the new 'ctraits' server 
command. 

• If the target user is logged in to any Community system, the message icon will show that the user is 
connected, and the user will receive the message when it is sent. 

• If the target user is not logged in to any Community system, the message icon will show that the user is not 
connected, and the user will receive the message when they next log in to any of the Community systems. 

• If the target user does not exist on any system, the message icon will show that the username is 
unrecognized, and the message will not be sent. 
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Note: Ctrl + W (Communicate > Message > Check Name) will only check the entered username 
against the local system; it will not query Community systems for possible matches. 

 

Installation Notes and Issues 

New End User License Agreement 
Beginning with version 2.8, an End User License Agreement (EULA) is part of the iNEWS client software 
installation. This EULA must be accepted for installation to proceed. Administrators should generate a new 
silent install script before rolling out the client. 

Upgrading iNEWS Client Software from Previous Versions 
When installing or upgrading iNEWS on Windows XP or Windows Server 2003, you must have adequate 
user rights to install the client software.  

Windows XP/Server 2003 

• Install as restricted user (will fail) 

• Install as standard user (Power User) (will succeed) 

• Install as administrator (will succeed) 

 

This is not a restriction in the iNEWS client install, but is a restriction of the Windows operating system in 
that it is upholding the security restrictions on the PC. 

Note: During the install procedure, iNEWS client versions 2.5 and higher will not provide an option 
to upgrade from iNEWS versions 2.1 and lower. Please uninstall iNEWS 2.1 or lower before installing 
iNEWS 2.5 or higher. 

Upgrading iNEWS v2.8 Client Software to Future Versions 
Due to changes made for Windows Vista, upgrades on Windows XP, Windows Server 2003, and Windows 
Vista require escalation to administrator privileges. When iNEWS administrators have set their system to 
roll out upgrades, Windows Limited and Power users will receive the iNEWS auto-upgrade dialog when 
logging in to a server. Once the user accepts the option to download the new installer they will receive a 
Run As dialog box in which an administrator's name and password must be entered to complete download 
and installation. If the Current user in the Run As dialog box is an administrator, it is necessary to deselect 
the check box called: Protect my computer and data from unauthorized program activity. for the upgrade to 
succeed. This is a Windows security restriction outside of iNEWS client control. 

Using the v2.8 download.exe program to download and upgrade to a new client version still requires a 
manual Run As… administrator. Limited users running download.exe without running the program as 
an administrator will not be able to complete installation. 

Upgrading iNEWS Server from Previous Versions 
• If moving to the Red Hat Enterprise Linux 5.0 version, a full OS and iNEWS install must be completed. 

There is no upgrade path from Red Hat 3.0 to Red Hat 5.0. 

• The installation CD-ROM now has two separate iNEWS installs. The install directories are now 
/server_RedHat3 and /server_RedHat5. Please install or upgrade the server using the folder 
appropriate for your operating system. 
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Qualified Asian Languages and IMEs 

Korean  
The following Korean IME (standard Windows IME) is tested and qualified: 

• Korean Input System (IME 2002) 

Known Issue – While the Korean-text queue navigation works correctly, the Go To > Destination menu 
option does not allow direct navigation to folders with Korean-text names. 

Chinese Simplified 
The following Chinese Simplified (PRC) IME (standard Windows IMEs) is tested and qualified: 

• Microsoft Pinyin IME 3.0 

• WangMa Wubi 86 

• WangMa Wubi 98 

Chinese Traditional 
The following Chinese Traditional IMEs (standard Windows IMEs) are tested and qualified: 

• New ChangJie 

• New Phonetic 

• ChangJie 

• Phonetic 

• DaYi 

The following Chinese Traditional IMEs (3rd party IMEs) have had minimal testing done and are not yet 
qualified or supported: 

• Boshamy (WuXiaMi) 

• Natural Input 

Japanese 
The following Japanese IME (standard Windows IME) was tested and qualified: 

• Microsoft Standard IME 2002 version 8.1 

Vietnamese 
The following Vietnamese IMEs were tested and qualified: 

• UniKeyNT 3.6 

o Input Methods: Telex and VNI 

o Character Set: Unicode 

• Vietkey 2000 Build 10727 

o Input Method: Telex 

o Character Set: Unicode Pre-Compound 

Known Issue with both Vietnamese IMEs - Certain Vietnamese characters do not get inserted correctly 
via keyboard macro when the IME is set to Vietnamese input. The workaround for this issue is to set the 
IME to English input before starting the macro. 
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Microsoft Windows Critical Updates 
Avid recognizes that it is very important to be able to deploy Microsoft security patches to our Windows-
based products as quickly as possible. We recommend that systems be kept up to date in order to maintain 
the highest level of security and encourage you to install all critical operating system updates provided by 
Microsoft.  

In the unlikely event that one of these updates causes an issue, it is recommended that you uninstall the 
update and contact Avid customer support as soon as possible. Avid will investigate the incompatibility and 
if necessary, will provide a software update or work around to allow our products to properly function with 
the Microsoft update in question. 

Known Issues and Limitations 

Multiple Monitors 
If running the iNEWS client software on a dual monitor workstation, there are some key issues you could 
encounter: 

• If the application is maximized at close, it will be maximized on the primary monitor when it is reopened, 
regardless of which monitor it was on when closed. 

• Moving a user from a dual monitor machine to a single monitor machine, such as an undocked laptop, 
could result in the application opening to a screen that no longer exists.  
 
Workaround: Right click on iNEWS in the Windows taskbar and select Move.  Then press one of the 
arrow keys on the keyboard; this will lock the application’s window to the mouse. You can then move the 
mouse pointer onto the screen and the iNEWS main window will move with it. 

Local Databases 
Local databases created in iNEWSv. 2.1 or earlier will produce two errors when first opened with an 
iNEWS v2.8.x client software. The first error will read: "The parameter is incorrect." The second error will 
read: "The process cannot access the file because it is being used by another process." The local database 
will work correctly after accepting the errors. This issue will be fixed in a future release. 

Vista 
The client auto-upgrade triggered by logging in to an iNEWS Workstation does not work on PCs with the 
Windows Vista operating system when upgrading from versions prior to 2.8. This is fixed in the iNEWS 
v2.8 client software, allowing future upgrades to succeed. 

Macros 
Some PCs, when upgraded from Internet Explorer 6 to Internet Explorer 7, will experience issues with 
macros that perform several functions in rapid succession; the macros might not complete all assigned 
activity in iNEWS. Avid is working with Microsoft on this issue.  

Workaround: Currently, the only available workaround is to add {pause <#>} statements of one or two 
seconds to problem macros at the point in the macro where activity ceases. 
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Technical Support Information 
Most products feature a number of coverage options. Avid Assurance service offerings are designed to 
facilitate your use of Avid solutions. Service options include extended telephone coverage, automatic 
software maintenance, extended hardware warranty, and preferred pricing on replacement parts. Offerings 
and options may vary by product and are not available for all products. 

For more information regarding Avid’s service offerings, visit www.avid.com/support or call Avid Sales at 
800-949-AVID (800-949-2843). 

Program availability and details might vary depending on geographic location and are subject to change 
without notice. Contact your local Avid office or your local Avid Reseller for complete program 
information and pricing. However, if you need help locating an Avid office or Avid Reseller near you, 
please visit www.avid.com or call in North America 800-949-AVID (800-949-2843). International users 
call 978-275-2480. 

Accessing Online Support 
Avid Online Support is available 24 hours per day, 7 days per week. Search the Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to read/join 
online message-board discussions. 

To access Avid Online Support: 

 Go to www.support.avid.com . 

Note: Supplemental documentation for this release, if available, is provided on the Knowledge Base. 
For the latest up-to-date information, browse the Knowledge Base at Avid Online Support. 

http://www.avid.com/support�
http://www.avid.com/�
http://www.support.avid.com/�
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Copyright and Disclaimer 

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc. 

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by visiting Avid's Web site at 

www.avid.com. The terms of that license are also available in the product in the same directory as the software. The software may not be reverse 

assembled and may be used or copied only in accordance with the terms of the license agreement. It is against the law to copy the software on any 

medium except as specifically allowed in the license agreement. 

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and 

recording, for any purpose without the express written permission of Avid Technology, Inc. 

Copyright © 2009 Avid Technology, Inc. and its licensors. All rights reserved.  

Attn. Government User(s). Restricted Rights Legend 

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer 

software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all 

rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS 

§227.7202-1(a), as applicable. 

Trademarks 

AirSPACE, AirSPACE HD, AirSpeed,  Avid, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid Mojo, AvidNet, AvidNetwork, 

AVIDstripe, Avid Unity, Avid Unity ISIS, Avid ISIS, Avid Xpress, iNEWS, iNEWS Command, iNEWS ControlAir, LaunchPad, 

make manage move | media, Marquee, Media Composer, MissionControl, Nearchive, NewsCutter, Nitris, OMF, OMF Interchange, OMM, 

Open Media Framework, Open Media Management, ProEncode, Pro Tools, QuietDriveSymphony, Trilligent, UnityRAID, Vari-Fi, Video Slave Driver, 

VideoSPACE, and Xdeck are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other countries. 

All other trademarks contained herein are the property of their respective owners. 

Avid iNEWS ReadMe • 0130-30257-01 Rev. A • 26 October 2009  

This document is distributed by Avid in online (electronic) form only, and is not available in printed form. 
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